| 7.1 | Viewing the product ReportPack version details | 48 |
| 7.2 | Checking the web for newer builds | 48 |

8. **Appendix: GFI LANguard default reports**  
8.1 Vulnerability assessment reports  
8.2 Network and software audit reports  
8.3 Results comparison  

9. **Troubleshooting**
9.1 Introduction  
9.2 Knowledge Base  
9.3 Web Forum  
9.4 Request technical support  
9.5 Build notifications  

**Index**  
87
1. Introduction

1.1 About GFI ReportCenter

GFI ReportCenter is a centralized reporting framework that allows you to generate various reports using data collected by different GFI products. GFI releases specialized reports for each of its products, referred to as a ReportPack; for example, the GFI LANguard ReportPack. A ReportPack can be downloaded as an add-on to the GFI product.

Figure 1 - Centralized reporting framework
A ReportPack plugs into the GFI Report Center framework; allowing you to generate, analyze, export and print the information generated through these reports.

1.2 About the GFI LANguard 9.0 ReportPack

The GFI LANguard ReportPack is a full-fledged reporting companion to GFI LANguard (GFI LANguard). It allows you to generate graphical IT-level, technical and management reports based on the network security audits carried out by GFI LANguard.

From trend reports for management (ROI) to daily drill-down reports for technical staff; the GFI LANguard ReportPack provides you with the easy-to-view information required, to fully identify any vulnerability on your corporate network.

The GFI LANguard ReportPack allows for the creation of various graphical and text based reports related to:

- Vulnerability assessment reports
- Network and software auditing reports
- Results comparison reports.

1.3 Components of the GFI LANguard 9.0 ReportPack

When you install the GFI LANguard 9.0 ReportPack, the following components are installed:

- GFI Report Center framework
- GFI LANguard 9.0 default reports
- Report scheduling service.
GFI Report Center framework

The GFI Report Center framework is the management console through which you can generate the specialized product reports which are shipped with a product ReportPack. The GFI Report Center framework offers a common application interface through which you can navigate, generate, customize and schedule reports.

```
1. Navigation Pane – Use this pane to access the navigation buttons/configuration options provided with GFI ReportCenter.
2. Product Selection drop-down list – Use this drop-down list to select the GFI product for which to generate reports. The Product Selection drop-down list displays all the products for which you have installed a ReportPack.
3. Favorite Reports – Use this navigation button to access your favorite/most used reports. For more information on how to add reports to this list refer to the ‘Adding default reports to the list of favorite reports’ and ‘Adding custom reports to the list of favorite reports’ sections in this manual.
4. Default Reports – Use this navigation button to access the default list of reports which can be generated for the selected product. For more information on default reports refer to the ‘GFI LANguard default reports’ section in this manual.
5. Custom Reports – Use this navigation button to access the list of customized reports which can be generated for the selected product. For more information on how to create custom reports refer to the ‘Custom reports’ chapter in this manual.
6. Scheduled Reports – Use this navigation button to access the list of scheduled reports for automatic generation and distribution. For more information on how to create scheduled reports refer to the ‘Scheduling reports’ chapter in this manual.
7. Options – Use this navigation button to access the general configuration settings for the GFI product selected in the Product Selection drop-down list.
```
**Help** – Use this navigation button to show this Quick Reference Guide in the Report Pane of the GFI ReportCenter management console.

**Report Pane** - Use this multi-functional pane to:
- View and analyze generated reports
- Maintain the scheduled reports list
- Explore samples and descriptions of default reports.

**Export** – Use this button to export generated reports to various formats including HTML, Adobe Acrobat (PDF), Excel (XLS), Word (DOC), and Rich Text Format (RTF).

**Send email** – Use this button to instantly distribute the last generated report via email.

---

**GFI LANguard 9.0 default reports**

The GFI LANguard 9.0 default reports are a collection of specialized pre-configured reports which plug into the GFI ReportCenter framework. These reports present the results of network security scans performed by GFI LANguard and allow for the generation of both graphical and tabular IT-Level, technical and management reports. Default reports can also serve as the base template for the creation of customized reports which fit specific network-reporting requirements.

**Report scheduling service**

The report scheduling service controls the scheduling and automatic distribution of reports by email. Reports generated by this service can also be saved to a specific hard disk location in a variety of formats which include DOC, PDF, RTF and HTML.

---

1.4 **Key features**

**Centralized reporting**

GFI ReportCenter is a one-stop, centralized reporting framework which enables the generation and customization of graphical and tabular reports for a wide array of GFI products.

**Wizard assisted configuration**

Wizards are provided to assist you in the configuration, scheduling and customization of reports.

**Report scheduling**

With GFI ReportCenter you can schedule reports to be generated on a pre-defined schedule as well as at specified intervals. For example, you can schedule lengthy reports to be generated after office hours. This allows you to maximize the availability of your system resources during working hours and avoid any possible disruptions to workflow.

**Distribution of reports via email**

GFI ReportCenter allows you to automatically distribute generated reports via email. In scheduled reports, this can be achieved automatically after the successful generation of a scheduled report.
Report export to various formats
By default, GFI ReportCenter allows you to export reports to various formats. Supported formats include HTML, PDF, XLS, DOC and RTF. When scheduling reports, you can optionally configure the preferred report output format. Different scheduled reports can also be configured to output generated reports to different file formats.

Default reports
The GFI LANguard ReportPack ships with a default set of graphical and tabular reports. These reports can be generated without any further configuration effort immediately after the installation. The default reports in this ReportPack are organized into three different report-type categories:
- Vulnerability assessment reports
- Network and software auditing reports
- Results comparison reports.

Report customization
The default reports that ship with every ReportPack can serve as the base template for the creation of customized reports. Report customization is achieved by building up custom data filters which will analyze the data source and filter the information that matches specific criteria. In this way, you create reports tailored to your reporting requirements.

Favorites
GFI ReportCenter allows you to create bookmarks to your most frequently used reports – both default and custom.

Printing
By default, all reports generated by GFI ReportCenter are printer friendly and can be printed through the windows printing services provided by the system where GFI ReportCenter is installed.
2. Installation

2.1 System requirements

Install the GFI LANguard ReportPack on a computer that meets the following requirements:

- Windows 2000 (SP4), XP (SP2/SP3), 2003, 2008, VISTA (SP1), operating system.
- Internet Explorer 5.1 or higher
- .NET Framework version 2.0
- MDAC 2.8
- GFI ReportCenter 3.6

**NOTE:** The GFI LANguard ReportPack only allows you to generate reports for data contained in scan results databases which were created and maintained by GFI LANguard.

2.2 Installation procedure

The GFI LANguard ReportPack includes an installation wizard which will assist you through the installation process. During the installation process this wizard will:

- Verify that you are running the latest version of the GFI ReportCenter framework; if you are installing the framework for the first time or the currently installed framework version is outdated, the installation wizard will automatically download the latest one for you.
- Automatically install all the required components distributed including the GFI ReportCenter framework, the GFI LANguard default reports and the Report Scheduling service.

To start the installation:

1. Double-click **LANguard9rp.exe**.
2. Select the required language.
3. Setup will next list all the missing prerequisites (if any). Install any missing prerequisites by selecting the prerequisite and choosing **Next**.

**NOTE:** If the current version of your GFI ReportCenter framework is not compatible with the GFI LANguard ReportPack, you will be prompted to download and install an updated version.

4. From the welcome screen, click **Next**.
5. Read the End User License Agreement, check the **I accept the license agreement** radio button and click **Next**.
6. If prompted enter your registration details and license key. Click **Next** to continue setup.
NOTE: If GFI LANguard is already installed, GFI ReportPack automatically registers the license key of GFI LANguard.
7. Select installation path or leave it as default and click Next.

2.3 Launching the GFI LANguard reports for GFI ReportCenter

Following the installation, launch the GFI LANguard Reports for GFI ReportCenter from Start ► Programs ► GFI ReportCenter ► GFI LANguard 9 ReportPack.

2.4 Selecting a product

When more than one product ReportPack is installed, use the Product Selection drop down list to select the GFI product ReportPack to be used.

For example, to run the reports provided in the GFI LANguard ReportPack:
1. Launch GFI ReportCenter from Start ► Program Files ► GFI ReportCenter.
2. Select GFI LANguard 9.0 from the Product Selection drop down list.

NOTE: Select the ALL PRODUCTS option to display and navigate all the Report Packs that are currently installed in GFI ReportCenter.
3. Getting started: Default reports

3.1 Introduction

After installing the GFI LANguard ReportPack, a number of specialized pre-configured reports can immediately be generated on the data stored in the database backend of GFI LANguard. These default reports are organized into the following categories:

- **Vulnerabilities Assessment reports**: Use the reports in this category to identify vulnerabilities detected on the network as well as information on network patches and service packs installed or awaiting deployment. The reports include vulnerability details such as host machines, operating systems affected, and severity.

- **Network and software audit reports**: Use the reports in this category to display detailed information on hardware and software present on the network. These reports help management in analyzing conformance with corporate security policy.

- **Results comparison reports**: Use the reports in this category to compare results of consecutive network scans that have a common profile and target, and of computer scans against a computer used as benchmark.

GFI LANguard default reports are accessed by clicking on the Default Reports navigation button provided in the navigation pane.

3.2 Generating a default report

To generate a default report:

1. Click on the Default Reports navigation button to bring up the list of default reports available.
2. Right-click on the report to be generated, select Run and specify the scan date/time period that will be covered by the report.

**Example 1: Generating a “Network Vulnerability Summary” report based on the last scan.**

This example demonstrates how to generate a network vulnerability summary report based on the last network security scan carried out:

1. Click on the Default Reports navigation button to bring up the list of available reports.
2. Right-click on Network Vulnerability Summary and select Run ► For Last Scan.

**Example 2: Generating a “Network Vulnerability Summary” report based on scans made on a particular day.**

This example demonstrates how to generate a network vulnerability summary report based on the scan performed on May 11, 2009.

1. Click on the Default Reports navigation button to bring up the list of available reports.
2. Right-click on Network Vulnerability Summary and select Run ► For Custom Date.
3. Select the **Day** option and expand the provided drop down. This will bring up the date selection calendar.

4. Navigate to the required month (i.e. May) and select the required day (i.e. 11).

5. Click **Next** to generate the report.

**Example 3: Generating a “Network Vulnerability Summary” report based on data collected over a specific date/time period.**

This example demonstrates how to generate a network vulnerability summary report based on network security scans carried out between May 1, 2009 and May 11, 2009.

1. Click on the **Default Reports** navigation button to bring up the list of available reports.

2. Right-click on **Network Vulnerability Summary** and select **Run ► For Custom Date**.
3. Select the ‘Date range’ option and specify the required parameters:
   - ‘From’ – 5/1/2009 12:00:00 AM.
   **NOTE:** Date and time format are based on the regional settings configured on your computer.
4. Click **Next** to generate the report.
3.3 Analyzing the generated report

Generated reports are shown in the right pane of the GFI ReportCenter. Use the toolbar at the top of the report pane to access common report related functions:

**Report browsing options**
- Browse the generated report page by page.
- Zoom in/Zoom out.
- Search the report for particular text or characters.
- Go directly to a specific page.
- Breakdown the report into a group tree (e.g. by date/time).
- Print report.

**Report storage and distribution options**
- Export the generated report to a specific file format.
- Distribute the generated report via email.

**NOTE:** For information on how to configure report storage and distribution options refer to the ‘Configuring Advanced Settings’ section in this manual.
3.4 Adding default reports to the list of favorite reports

You can group and access frequently used reports through the Favorite Reports navigation button. To add a default report to the list of favorite reports:

1. Click on the Default Reports navigation button to bring up the list of available reports.
2. Right-click on the default report that you wish to be added to favorites and select Add to favorites list.
3. Click Yes to confirm.
### 4. Custom reports

#### 4.1 Introduction

GFI ReportCenter allows you to create custom reports which are tailored to your reporting requirements. This is achieved by building up custom data filters which will analyze the data source and filter out the information that matches the specified criteria.

#### 4.2 Creating a new custom report

To create a custom report:

1. Click on the Default Reports navigation button.
2. Right-click on the default report to be used as template and select New ► Custom Report. This will bring up the 'Custom Report Wizard'.

   ![Custom Report Wizard Screenshot](image)

   **Screenshot 8 - Selecting the scan data source to use**

3. Specify the data source option that will be used to generate the custom report. This data source refers to scan results from:
   - the last scan
   - particular scan(s)
   - scans carried out over a specific date/time period.

   Click **Next** to continue.
4. If using the **Particular Scan** option, select the required scan(s) from the list of network security scans carried out on the corporate network. Click **Next** to continue.

5. Configure the data filter conditions that will be applied against the selected data source. Click **Next** to continue.
6. If using the **Scans over a date/time range** option, select the date/time period from which network security scan results will be gathered. Click **Next** to continue.

**NOTE:** For more information on how to configure filter conditions, refer to the section ‘Configuring data filter conditions’ in this manual.

7. Specify a name and description for the customized report. Click on **Next** to continue.

8. Click on **Finish** to finalize your configuration settings.
4.3 Configuring data filter conditions

Use data filter conditions to specify which network security scan data/results will be included in the report. Only scans which match the specified criteria will be processed and presented within the report.

![Screenshot 12 - Custom Report Wizard: Filters dialog](image)

Click on the **Add...** button to bring up the ‘Edit filter properties’ dialog and configure the following conditions:

- **Filter condition** – Specify the data source area on which the filter will focus (for example, select ‘Operating System’ to filter the events data related to a specific operating system).
- **Condition** – Specify the condition comparison parameter.
- **Value** – Specify the string to which source data will be compared.

For example to generate a report which contains only information related to Windows XP, configure your filter parameters as shown below:
For more specific reports, you can limit the range of information to be displayed by tightening your conditions/search criteria. This is achieved by configuring and applying multiple data filters against the selected data source. When more than one filter is used, specify how these filters will be logically linked. This is achieved by selecting a logical grouping condition from ‘Filter property condition…’ drop down list.

- Select **And** to include ALL the scan data information that satisfies ALL of the conditions specified in the filters.
- Select **Or** to include ALL the scan data information that matches at least one of the specified filter conditions.
Example: Using multiple filters

Consider the situation where a custom report has 2 filters configured as follows:

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Filter 1</th>
<th>Filter 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter condition</td>
<td>Hostname</td>
<td>Operating System</td>
</tr>
<tr>
<td>Logical relation</td>
<td>Is equal to</td>
<td>Is equal to</td>
</tr>
<tr>
<td>Value</td>
<td>'Mark'</td>
<td>'Windows XP'</td>
</tr>
</tbody>
</table>

The data which will be included in this custom report will vary according to how these filters will be applied against your data. This is defined through the ‘Filter property condition…’ drop-down.

<table>
<thead>
<tr>
<th>Filters applied</th>
<th>Data output</th>
</tr>
</thead>
</table>
| Filter 1 and Filter 2 | **The report will show:**
  All scan data which is related to a host called ‘Mark’ which runs on ‘Windows XP’. |
| Filter 1 or Filter 2 | **The report will show:**
  All scan data related to ‘Windows XP’ – (no matter which host it belongs to)
  AND
  All scan data related to a host called ‘Mark’ – (no matter which operating system it has installed). |

Example: Creating a custom report based on network security scans performed during a particular month

This example demonstrates how to generate a network vulnerabilities summary report called ‘Network vulnerabilities summary on hostname Mark for January 2009’. This report will be based on scans:

- Related to a host named ‘Mark’
- Corresponding to operating system ‘Windows XP’
- Performed during the month of ‘January 2009’.
To create this report:
1. Click on the **Default Reports** navigation button.
2. Right-click on the report to be customized and select **New ▶ Custom Report**. This will bring up the ‘Custom Reports Wizard’.
3. As soon as the welcome dialog is displayed, click **Next**.

4. Select the **Scans over a date/month range** option and click **Next**.

5. Select the **Month** option and specify the following parameters:
- **Month**: ‘January’.
- **Year**: ‘2009’.

6. Click on **Next** to proceed to the data filters dialog.

7. Click on the **Add…** button and configure the parameters of filter 1 as follows:
   - **Filter condition**: ‘Hostname’
   - **Condition**: ‘Equal to’
   - **Value**: ‘Mark’.

8. Click **Add** to finalize your filter configuration settings.

9. Click again on the **Add…** button and configure the parameters of filter 2 as follows:
   - **Filter condition**: ‘Operating system’
   - **Condition**: ‘is equal to’
   - **Value**: ‘Windows Vista’

10. Click **Add** to finalize your filter configuration settings.

11. Click **Next** and specify the following parameters:
   - **Report Name**: ‘Network Vulnerability summary for November 2008’
   - **Report Title**: ‘Network security scans of hostname Mark’
   - **Report Description**: ‘This report shows a summary of vulnerabilities found on hostname Mark during November 2008.’
12. Click **Next** to proceed to the final dialog.
13. Click **Finish** to finalize your custom report configuration settings.

### 4.4 Run a custom report

To run a custom report:

1. Click on the **Custom Reports** navigation button.
2. Right-click on the custom report to be generated and select **Generate**.

### 4.5 Editing a custom report

To edit the configuration settings of a custom report:

1. Click on the **Custom Reports** navigation button.

2. Right-click on the custom report to be modified and select **Edit**. This will bring up the ‘Custom Reports Wizard’ through which you can make the required changes.

**NOTE:** For more information on how to configure the parameters of a custom report refer to the ‘Creating a custom report’ section in this chapter.
4.6 Deleting a custom report

To delete a custom report:
1. Click on the Custom Reports navigation button.
2. Right-click on the custom report to be permanently removed from the list and select Delete.
3. Click Yes to confirm.

4.7 Adding custom reports to the list of favorite reports

You can group and access frequently used reports through the Favorite Reports navigation button. To add a custom report to the list of favorite reports:
1. Click on the Custom Reports navigation button to bring up the list of available reports.
2. Right-click on the custom report to be added to favorites and select Add to Favorites List.
3. Click Yes to confirm.
5. Scheduling reports

5.1 Introduction

GFI ReportCenter allows you to generate reports on a pre-defined schedule as well as at specified intervals. This way you can automate the generation of reports that are required on regular basis/periodically.

Further to this, GFI ReportCenter can also be configured to automatically distribute scheduled reports via email. For every scheduled report, you can configure custom emailing parameters including the list of report recipients and the file format (e.g. PDF) in which the report will be attached to the email.

Use the report scheduling feature to automate your report generation requirements. For example, you can schedule lengthy reports after office working hours and automatically email them to the intended recipients. This way, you maximize the availability of your system resources during working hours and avoid any possible disruptions to workflow.

Both default and custom reports can be scheduled for automatic generation.

5.2 Scheduling a report

To schedule a report:

1. Click on the Default/Custom Reports option pane.

2. Right-click on the report to be scheduled and select New ► Scheduled report. This will bring up the ‘Scheduled Report Wizard’. Click on Next to continue.

3. Select the network security scan(s) data to be covered by this report.
4. Specify the report scheduling parameters (date/time/frequency). Click on **Next** to continue.

5. To export the generated report to file, select the **Export to file** option. To customize the report export configuration settings click on the **Settings** button underneath this option.

**NOTE:** For information on how to configure export-to-file settings refer to the ‘Configuring report export to file options’ section in this chapter.
6. To automatically distribute generated reports via email, select the **Send by mail** option. To customize the email settings used for report distribution click on the **Settings** button underneath this option.

**NOTE:** For information on how to configure email settings refer to the **Configuring report emailing options** in this chapter.

7. Specify a name and description for this scheduled report. Click **Next** to continue.

8. Click **Finish** to finalize your settings.

### 5.3 Configuring advanced settings

GFI LANguard ReportPack allows you to export scheduled reports to a specific file format as well as to automatically distribute these reports via email. This is achieved using either a set of parameters (e.g. recipient’s email addresses) which are specified on the fly during scheduled report configuration or using the default set of report export and distribution parameters configured during the ReportPack installation.

**NOTE:** The Report Scheduling Wizard is by default configured to use the default set of report export and distribution parameters.

### Report export formats

Scheduled reports can be exported in a variety of formats. Supported file formats include:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Adobe Acrobat (.PDF)</td>
<td>Use this format to allow distribution of a report on different systems such as Macintosh and Linux while preserving the layout.</td>
</tr>
<tr>
<td>2 MS Excel (.XLS)</td>
<td>Use this format if you want to further process the report and perform more advance calculations using another (external) program such as Microsoft Excel.</td>
</tr>
<tr>
<td>3 MS Word (.DOC)</td>
<td>Use this format if you want to access this report using Microsoft Word.</td>
</tr>
<tr>
<td>4 Rich text format (.RTF)</td>
<td>Use this format to save the report in a format that is small in size and which allows accessibility through different word processors in different operating systems.</td>
</tr>
</tbody>
</table>

### 5.3.1 Configuring report export to file options

To configure the report export to file settings of a scheduled report do as follows:

1. From the **Advanced Settings** dialog, click on the **Settings** button underneath the **Export to file** option.
2. Select the option **Override the default folder options for this report**: 
3. Specify the complete path where the exported report will be saved. 
4. Specify the file format in which the exported report will be saved. 
5. Click **OK** to finalize your configuration settings. 

**NOTE:** For information on how to configure the default export to file settings refers to the ‘Configuring default scheduling options’ section in this manual.

### 5.3.2 Configuring report emailing options

To configure the report emailing options of a scheduled report do as follows:

1. From the **Advanced Settings** dialog, click on the **Settings** button underneath the **Send by email** option.
2. Select the option **Override the default email options for this report**:  

3. Specify the following parameters:
   - **To/CC**: Specify the email address (es) where the generated report will be sent.  
   - **From**: Specify the email account that will be used to send the report.  
   - **Server**: Specify the name/IP of your SMTP (outbound) email server. If the specified server requires authentication, select the option **SMTP Server requires login** and specify the logon credentials in the **User name** and **Password** fields.  
   - **Report format**: Reports are sent via email as attachments. Select the file format in which to send out your report.

4. Click **OK** to finalize your configuration settings.
5.4 Viewing the list of scheduled reports

Click on the Scheduled Reports navigation button to show the list of scheduled reports which are currently configured for automatic generation. This information is displayed in the right pane of the management console and includes the following details:

- **Schedule Name:** The custom name that was specified during the creation of the new scheduled report.
- **Report Name:** The names of the default or custom report(s) that will be generated.
- **Last Generation:** Indicates the date/time when the report was last generated.
- **Next Generation:** Indicate the date/time when the report is to be next generated.
- **Description:** The description that you have entered for each schedule.
- **Report Pack:** The GFI LANguard version that created the report.
5.5 Viewing the scheduled reports activity

GFI ReportCenter also includes a schedule activity monitor through which you can view events related to all scheduled reports that have been executed.

To open the schedule activity monitor, click on the Scheduled Reports navigation button and select the Scheduled Reports Activity node. This will bring up the activity information in the right pane of the GFI ReportCenter management console.

The activity monitor displays the following events:

- **Information**: The scheduled report was successfully executed and sent by email and/or saved to disk.
- **Warning**: The scheduled report was not executed because product license is invalid or has expired.
- **Error**: The scheduled report was not executed due to a particular condition/event. Typical conditions include:
  - Errors when attempting to save the generated report to a specific folder (for example, out of disk space).
  - Errors when attempting to send the generated report via email (for example, the SMTP server configured in the GFI ReportCenter settings is not reachable).
The activity monitor records and enumerates the following information:

- **Date**: The date and time when the scheduled report was executed.
- **Product name**: The name of the GFI product to which the report belongs.
- **Type**: The event classification - error, information, or warning.
- **Description**: Information related to the state of a scheduled report that has been executed. The format and contents of the activity description vary, depending on the event type.

**NOTE**: The description is often the most useful piece of information, indicating what happened during the execution of a scheduled report or the significance of the event.

## 5.6 Enable/disable a scheduled report

Scheduled reports can be enabled or disabled as required. Use the Scheduled Reports navigation button to view the list of scheduled reports as well as to identify their current status. The status of scheduled reports is shown through the icon included on the left hand side of each schedule:

- ![Disabled](icon_disabled.png) Indicates that the scheduled report is disabled.
- ![Enabled/Pending](icon_enabled_pending.png) Indicates that the scheduled report is enabled/pending.

To enable or disable a scheduled report, right-click on the respective report and select **Enable/Disable** accordingly.

## 5.7 Editing a scheduled report

To make changes to the configuration settings of a scheduled report:

1. Click on the Scheduled Reports navigation button.
2. Right-click on the scheduled report to be re-configured and select **Properties**. This will bring up the 'Scheduled Reports Wizard'.
3. Click on **Next** and perform the required changes. For information on how to configure the parameters of a scheduled report refer to the ‘Creating a scheduled report’ section in this chapter.

**Deleting a scheduled report**

To delete a scheduled report:
1. Click on the **Scheduled Reports** navigation button.
2. Right-click on the scheduled report to be permanently removed from the list and select **Delete**.

---

**5.8 Example: Scheduling a report**

This example demonstrates how to schedule a software audit report which will:

- Generate the first report on 5/12/2009 at 8:00:00 PM.
- Continue generating the same report on a monthly basis.
- Export the generated report(s) to folder ‘C:\Monthly Reports’ in PDF format.
- Email the generated report using the following custom parameters:
  - Send from email account: ‘RC_Admin@gfi.com’
  - Send to email account: ‘IT_manager@gfi.com’
  - SMTP server details: ‘120.11.120.11.

To create the scheduled report:
1. Click on the **Default Reports** navigation button.
2. Right-click on **Network Vulnerability Summary** and select **New ★ Scheduled Report**. As soon as the welcome dialog is displayed click **Next**.
3. Select the option **Scans over a date/time range** for data to be covered by this report and click **Next**.

4. Select the option **Relative** and from the provided drop down list select **Last month**. Click on **Next** to proceed to the next dialog.
5. To generate this report on a monthly basis, select the option **Generate this report every:** and set the interval to **30 Days**.

6. Set the start date to ‘5/12/2009’ and time to ‘8:00:00 PM’. Click **Next** to continue.

7. From the **Advanced Settings** dialog, click on the **Settings** button underneath the **Export to file** option.
8. Select the option **Override the default folder options for this report**: 

9. Specify the complete path where this report will be saved i.e. ‘C:\Monthly Reports’. 

10. From the report format drop down select **PDF** and click **OK**.

11. From the **Advanced Settings** dialog, click on the **Settings** button underneath the **Send by email** option.
12. Select the option **Override the default email options for this report**:  
13. Specify the following parameters:  
   - **To**: ‘RC_Admin@gfi.com’  
   - **From**: ‘IT_manager@gfi.com’  
   - **Server**: ‘120.11.120.11’.  
14. From the report format drop down select **PDF** and click **OK** to finalize your email settings.
15. Click **Next** and specify the following parameters:
   - **Report Name**: ‘Monthly report: ‘Software Audit’
   - **Report Title**: ‘Software Audit – Executive reports’
   - **Report Description**: This report is generated on a monthly basis and shows an executive summary of software installed on the network.

16. Click **Next** to proceed to the final dialog.

17. Click **Finish** to finalize your custom report configuration settings.
6. Configuring default options

6.1 Introduction

The GFI LANguard ReportPack allows you to configure a default set of parameters which can be used when generating reports. These parameters are first set during installation. However, you can still reconfigure any of these parameters via the Options navigation button and the Tools menu provided in the GFI ReportCenter management console.

Through the Options navigation button you can configure the following parameter:

**Database source:** Use this node to specify the database backend from where the ReportPack will extract the required reporting data.

Through the Tools menu you can configure the following parameters:
- **Default scheduling settings**: Use this menu option to configure the default export to file parameters and report emailing parameters of scheduled reports.

You can also backup your configuration settings for the ReportPack through the **Import/Export Configuration** node in the **Options** section. Exported configurations may be imported into a separate GFI ReportCenter instance, provided that the same ReportPacks are installed on both instances.

### 6.2 Configuring database source: Microsoft SQL Server

To configure MS SQL Server your database source:

1. Click on the **Options** navigation button.
2. Right-click on the **Database Source** node and select **Set Database Source...** This will bring up the database source configuration dialog.

![Database Source Configuration Dialog](Screenshot 38 - Database source configuration dialog: SQL Server)

3. Select **MS SQL Server** as the database type from the provided list of supported databases.
4. Specify the name or IP address of your MSDE/MS SQL Server database backend.
5. To use the credentials of an SQL Server account, select the **Use SQL Server authentication** option and specify the user name and password in the provided fields.

**NOTE:** By default, the GFI LANguard ReportPack uses Windows logon credentials to authenticate to the SQL Server.
6. Click on **OK** to finalize your configuration settings.

### 6.3 Configuring database source: Microsoft Access

To configure Microsoft Access as your database source:

1. Click on the **Options** navigation button.

2. Right-click on the **Database Source** node and select **Set Database Source**… This will bring up the database source configuration dialog.

3. Select **MS Access** as the database type from the provided list of supported databases.

4. Specify the complete path to the database backend. If the database source is not stored locally, specify the complete path using Universal Naming Convention (UNC).

   (e.g. `\\Security_Server\Program Files\GFI\LANguard9\Data\scanresult.mdb`).

5. Click on **OK** to finalize your configuration settings.
6.4 Viewing the current database source settings

After configuration, you can view the current database source settings by clicking on the Database Source node.

6.5 Configuring default scheduling settings

To configure the default settings to be used by scheduled reports:

1. From the pull-down menu, click on the Tools ► Default Scheduling Options.
2. Configure the required parameter as described in the ‘Configuring Advanced Settings’ section of the Scheduling Reports chapter.
6.6 Importing/Exporting the configuration

![Screenshot 42 – Import/Export Configuration node](image)

The GFI ReportCenter allows you to backup your configuration settings for the ReportCenter and all Report Packs through **Import/Export Configuration**… in the **File** pull-down menu. Settings are exported for:

- Default scheduling options
- Custom reports
- Scheduled reports
- Favorite reports.

The configuration is backed up into an XML file which may be imported into a separate GFI ReportCenter instance, provided that the same Report Packs are installed on both instances.

You can also import/export the configuration for a particular Report Pack through the **Import/Export Configuration** node in the **Options** section of the Report Pack.
Exporting the configuration

To export the GFI LANguard configuration:

1. From the pull-down menu, click on the File ▶ Import/Export Configuration…. This will bring up the configuration dialog.
2. Select the option Export configurations options.
3. Specify which configuration options to export.
4. Specify the path and filename of the XML file to export. Click on OK to proceed with the export.

Screenshot 43 – Import/Export configuration dialog
Screenshot 44 – Export configuration success
Importing the configuration

To import the GFI LANguard configuration:

1. From the pull-down menu, click on the File ▶ Import/Export Configuration…. This will bring up the configuration dialog.
2. Select the option Import configurations options.
3. Specify which configuration options to import.
4. Specify the path and filename of the XML file to import. Click on OK to proceed with the import.
5. Close and restart GFI ReportCenter to activate the imported items.
7. General options

7.1 Viewing the product ReportPack version details

To view the version information of your product Report Packs:

1. Select the product ReportPack from the Product Selection drop down list.
2. Click on the Options navigation button and select the Version Information node. The version details will be displayed in the right pane of the management console.

7.2 Checking the web for newer builds

Periodically GFI releases product and ReportPack updates which can be automatically downloaded from the GFI website. To check if a newer build is available for download:

1. Select the respective product (for example, GFI LANguard 9.0 Reports) from the Product Selection drop down list.
2. Click on the **Options** navigation button.
3. Right-click on the **Version Information** node and select **Checking for newer builds**...

**NOTE:** GFI LANguard 9.0 ReportPack is configured by default to check for newer builds on startup.
8. Appendix: GFI LANguard default reports

8.1 Vulnerability assessment reports

8.1.1 Network vulnerability summary

<table>
<thead>
<tr>
<th>Hosts Severity Level Distribution</th>
<th>Top 10 Vulnerable Hosts (by Severity)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IP Address</strong></td>
<td><strong>Host Name</strong></td>
</tr>
<tr>
<td>80.143.32.223</td>
<td>Andy</td>
</tr>
<tr>
<td>80.143.32.211</td>
<td>Andrew</td>
</tr>
<tr>
<td>80.143.32.140</td>
<td>Jane</td>
</tr>
<tr>
<td>80.143.32.221</td>
<td>Joe2</td>
</tr>
<tr>
<td>80.143.32.226</td>
<td>GamePC</td>
</tr>
<tr>
<td>92.158.102.175</td>
<td>Julia</td>
</tr>
<tr>
<td>92.158.102.176</td>
<td>Steve</td>
</tr>
</tbody>
</table>

Screenshot 49 – Sample report showing network vulnerability summary

1. Chart displaying vulnerability severity distributions

2. List showing the top 10 most vulnerable host machines ordered by severity

3. Chart displaying vulnerability level distributions across host machines on the network
Appendix: GFI LANguard default reports

1. Chart displaying the vulnerability distribution for each operating system on the network

2. Chart displaying vulnerability categories and their distribution
Appendix: GFI LANguard default reports

GFI ReportCenter

Screenshot 52 – Sample report showing network vulnerability summary

Vulnerability Distribution (by Timestamp)

<table>
<thead>
<tr>
<th>Vulnerability Category</th>
<th>Severity Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Three Months</td>
<td>Total</td>
</tr>
<tr>
<td>Last Year</td>
<td>0</td>
</tr>
<tr>
<td>Older than One Year</td>
<td>288</td>
</tr>
</tbody>
</table>

Chart displaying the vulnerability distribution over time

Top 10 Most Common Vulnerabilities

<table>
<thead>
<tr>
<th>Product</th>
<th>Timestamp</th>
<th>References</th>
<th>Type</th>
<th>Severity</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Malicious Software Removal Tool - January 2007 (KB9081530)</td>
<td>2007-01-09</td>
<td>N/A</td>
<td>Missing Update</td>
<td>High</td>
<td>5</td>
</tr>
<tr>
<td>AutoShareWKS</td>
<td>2002-01-01</td>
<td>N/A</td>
<td>Registry</td>
<td>Low</td>
<td>3</td>
</tr>
<tr>
<td>Security Update for Microsoft Data Access Components (KB932483)</td>
<td>2005-02-17</td>
<td>N/A</td>
<td>Missing Update</td>
<td>High</td>
<td>3</td>
</tr>
<tr>
<td>Security Update for Windows Media Player Plug-in (KB311564)</td>
<td>2006-03-14</td>
<td>N/A</td>
<td>Missing Update</td>
<td>High</td>
<td>3</td>
</tr>
<tr>
<td>Security Update for Windows XP (KB920065)</td>
<td>2006-09-12</td>
<td>N/A</td>
<td>Missing Update</td>
<td>Medium</td>
<td>3</td>
</tr>
<tr>
<td>Security Update for Microsoft Windows (KB924105)</td>
<td>2003-09-09</td>
<td>N/A</td>
<td>Missing Update</td>
<td>High</td>
<td>3</td>
</tr>
<tr>
<td>Security Update for Windows XP (KB912919)</td>
<td>2005-01-05</td>
<td>N/A</td>
<td>Missing Update</td>
<td>High</td>
<td>2</td>
</tr>
<tr>
<td>Security Update for Windows XP (KB911927)</td>
<td>2006-02-14</td>
<td>N/A</td>
<td>Missing Update</td>
<td>High</td>
<td>2</td>
</tr>
</tbody>
</table>

Screenshot 53 – Sample report showing network vulnerability summary

Top 10 Most Vulnerable Products

<table>
<thead>
<tr>
<th>Product</th>
<th>Severity Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Total: 262</td>
</tr>
<tr>
<td>Microsoft Windows NT</td>
<td>Total: 1</td>
</tr>
</tbody>
</table>

Charts displaying:
- The 10 most common vulnerabilities
- The 10 most vulnerable products

Use this report to:
- Display vulnerability counts for different categories
- Identify the 10 most vulnerable host machines
- Identify the 10 most vulnerable products
- Identify the 10 most common vulnerabilities.

### 8.1.2 Network vulnerability trend

![Vulnerability detections over time chart]

This trend report was generated from data in the following scans:

1. Chart displaying past scans and vulnerability totals for each scan
2. List of past scans and respective scan profiles

Use this report to:

- Graphically illustrate how the number of vulnerabilities on the network has changed over a given time span.

### 8.1.3 Vulnerability distribution by host

![Vulnerability distribution chart]

1. List of IP addresses and host names on which vulnerabilities were detected
2. The number of low, medium and high severity vulnerabilities detected on each host
3. The number of vulnerabilities detected on each host distributed by vulnerability category
Use this report to:

- Generate statistics showing vulnerability counts for each host machine.

### 8.1.4 Vulnerability distribution by operating system

<table>
<thead>
<tr>
<th>Operating System / SP</th>
<th>Vulnerability Categories</th>
<th>Low</th>
<th>Med</th>
<th>High</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000 SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Windows XP SP</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Screenshot 56 – Sample report showing vulnerability distribution by operating system**

1. List of operating systems and service packs affected by one or more vulnerabilities
2. The number of low, medium and high severity vulnerabilities detected on each operating system
3. The number of vulnerabilities detected on each operating system distributed by vulnerability category

Use this report to:

- Generate statistics showing vulnerability counts for each operating system.

### 8.1.5 Security scans history

**Most Scanned Systems**

<table>
<thead>
<tr>
<th>IP address</th>
<th>Host Name</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>00.143.32.233</td>
<td>Andy</td>
<td>8</td>
</tr>
<tr>
<td>00.143.32.229</td>
<td>GamesPC</td>
<td>5</td>
</tr>
<tr>
<td>00.143.32.221</td>
<td>Joe2</td>
<td>5</td>
</tr>
<tr>
<td>00.143.32.211</td>
<td>Andrew</td>
<td>5</td>
</tr>
<tr>
<td>00.143.32.140</td>
<td>Jane</td>
<td>5</td>
</tr>
<tr>
<td>02.168.102.176</td>
<td>Steve</td>
<td>4</td>
</tr>
<tr>
<td>02.168.102.175</td>
<td>Julia</td>
<td>4</td>
</tr>
</tbody>
</table>

**Least Scanned Systems**

<table>
<thead>
<tr>
<th>IP address</th>
<th>Host Name</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>02.168.102.176</td>
<td>Steve</td>
<td>4</td>
</tr>
<tr>
<td>00.143.32.229</td>
<td>GamesPC</td>
<td>5</td>
</tr>
<tr>
<td>00.143.32.221</td>
<td>Joe2</td>
<td>5</td>
</tr>
<tr>
<td>00.143.32.211</td>
<td>Andrew</td>
<td>5</td>
</tr>
<tr>
<td>00.143.32.140</td>
<td>Jane</td>
<td>5</td>
</tr>
<tr>
<td>02.168.102.176</td>
<td>Steve</td>
<td>4</td>
</tr>
</tbody>
</table>

**Most Used Profiles**

<table>
<thead>
<tr>
<th>Profile</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Scan</td>
<td>4</td>
</tr>
<tr>
<td>Ping them All</td>
<td>2</td>
</tr>
</tbody>
</table>

**Screenshot 57 – Sample report showing security scans history**

1. List showing the host machines with the highest number of scans and the respective scan count
2. List showing the host machines with the lowest number of scans and the respective scan count
Use this report to:

- Display information and statistics on all network security scans performed.

8.1.6 Vulnerability listing by category

Screenshot 59 – Sample report showing vulnerability listing by category

1 Vulnerability details including name, description and severity

2

3

Chart displaying scan profile usage

4

List showing date and time of the last scan performed on each host

5

List showing all scans performed

List showing all scans performed
Appendix: GFI LANguard default reports

GFI ReportCenter

List of host machines affected by each vulnerability detected

Use this report to:

- List detected vulnerabilities grouped by category, and the host machines affected by each vulnerability.

8.1.7 Vulnerability listing by host

Use this report to:

- List the vulnerabilities detected for each host machine on the network.

Screenshot 60 – Sample report showing vulnerability listing by host

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Host machine details on which vulnerabilities were detected</td>
</tr>
<tr>
<td>2</td>
<td>Vulnerability count for each host, also shown as a percentage of total vulnerabilities detected on the network</td>
</tr>
<tr>
<td>3</td>
<td>List of vulnerability details for each host, including name, description and severity</td>
</tr>
<tr>
<td>4</td>
<td>Chart displaying percentage of vulnerabilities detected on each host compared to total vulnerabilities detected on the network</td>
</tr>
</tbody>
</table>

Use this report to:

- List the vulnerabilities detected for each host machine on the network.
8.1.8 Vulnerability listing by product

<table>
<thead>
<tr>
<th>PRODUCT</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vulnerability</td>
<td>A connection could be opened using account Administrator without password! - You MUST set a password for the administrator account and/or disable guest logons.</td>
</tr>
<tr>
<td>Category</td>
<td>Services</td>
</tr>
<tr>
<td>Severity</td>
<td>High</td>
</tr>
<tr>
<td>Timestamp</td>
<td>N/A</td>
</tr>
<tr>
<td>Affected Hosts</td>
<td>IP address</td>
</tr>
<tr>
<td>80.143.32.221</td>
<td>Joe2</td>
</tr>
<tr>
<td>80.143.32.222</td>
<td>Andy</td>
</tr>
</tbody>
</table>

Vulnerability: Auto Logon - Automatic logon uses the domain, user name, and password stored in the registry to log users on to the computer when the system starts. The problem with automatic logon is the fact that any user can start your computer and log on using your account. Automatic logon proceeds differently from authenticated logon, and can cause timing conflicts. For example, if one is loading several network transport protocols, automatic logon might cause Windows 2000 to attempt to connect to some network resources before the protocols’ network transports are completely

| Affected Hosts | IP address | Host Name | Operating System | SP |
| 80.143.32.226 | GamesPC | Windows XP | 2 |
| 82.169.112.175 | Julia | Windows XP | 2 |

Screenshot 61 – Sample report showing vulnerability listing by product

1. Name of product for which vulnerabilities were detected
2. Vulnerability details for each product, including name, description and severity
3. List of host machines affected by each product vulnerability detected

Use this report to:
- List detected vulnerabilities grouped by product, and the host machines affected by each vulnerability.

8.1.9 Vulnerability listing by severity

<table>
<thead>
<tr>
<th>SEVERITY</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vulnerability</td>
<td>814078: Security Update (Microsoft Jscript version 5.6, Windows 2000, Windows XP)</td>
</tr>
<tr>
<td>Category</td>
<td>Missing Updates</td>
</tr>
<tr>
<td>Product</td>
<td>Windows</td>
</tr>
<tr>
<td>Timestamp</td>
<td>2003-11-21</td>
</tr>
<tr>
<td>Affected Hosts</td>
<td>IP address</td>
</tr>
<tr>
<td>80.143.32.221</td>
<td>Joe2</td>
</tr>
</tbody>
</table>

Vulnerability: 816983: Security Update Microsoft Virtual Machine (Microsoft VM)

| Affected Hosts | IP address | Host Name | Operating System | SP |
| 80.143.32.221 | Andrew | Windows 2000 | 4 |
| 80.143.32.233 | Andy | Windows XP | 1 |

Screenshot 62 – Sample report showing vulnerability listing by severity

1. Severity level
2. Vulnerability details for each severity level, including name and description
3. List of host machines affected by vulnerabilities detected for each security level
Use this report to:
- List detected vulnerabilities grouped by severity, and the host machines affected by each vulnerability.

### 8.1.10 Open Trojan ports by host

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Windows XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Pack</td>
<td>2</td>
</tr>
<tr>
<td>Open Port Count</td>
<td>4</td>
</tr>
<tr>
<td>Open Ports</td>
<td></td>
</tr>
<tr>
<td>Er0:32</td>
<td></td>
</tr>
<tr>
<td>Eclipse 2000, Sanctuary</td>
<td></td>
</tr>
<tr>
<td>Exploiter, FreddyK, Kid Terror, Schwindler, Sensitive, Winsp00fer</td>
<td></td>
</tr>
<tr>
<td>Duckboy</td>
<td></td>
</tr>
</tbody>
</table>

Use this report to:
- List open ports, grouped by host machine, which could potentially serve as a backdoor for Trojans.

### 8.1.11 Open Trojan ports

<table>
<thead>
<tr>
<th>Port Description</th>
<th>Open Port Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exploiter, FreddyK, Kid Terror, Schwindler, Sensitive, Winsp00fer</td>
<td>2</td>
</tr>
<tr>
<td>Duckboy</td>
<td>1</td>
</tr>
<tr>
<td>Eclipse 2000, Sanctuary</td>
<td>1</td>
</tr>
<tr>
<td>Er0:32</td>
<td></td>
</tr>
</tbody>
</table>

Use this report to:
- List the 20 most common open Trojan ports found on the network, which could potentially serve as a backdoor for Trojans.
8.1.12 Top SANS vulnerabilities status

Screenshot 65 – Sample report showing top SANS vulnerabilities status

1. Host machine details on which vulnerabilities reported by SANS were detected
2. List showing SANS vulnerability details, including name, description and product affected. SANS vulnerabilities are grouped by year and chapter

Use this report to:
- List the vulnerabilities detected for each host machine, based on the SANS top-20 report of vulnerabilities.

8.1.13 Vulnerable hosts based on open ports

Screenshot 66 – Sample report showing vulnerable hosts based on open ports

1. List showing the top 20 host machines most likely to be compromised by Trojans

Use this report to:
- List the 20 most vulnerable host machines, based on the number of open Trojan ports found.

8.1.14 Vulnerable hosts based on vulnerability level

Screenshot 67 – Sample report showing vulnerable hosts based on vulnerability level
Host machine details showing the number of vulnerabilities and missing patches detected according to criticality

Use this report to:

- List the 20 most vulnerable host machines for each network security scan, based on vulnerability level.

### 8.1.15 Network patching status

#### Missing And Installed Service Packs

![Pie chart showing installed and missing service packs](image)

- Installed: 3
- Missing: 2
- Total: 5

#### Missing And Installed Patches by Severity

![Bar chart showing installed and missing patches by severity](image)

<table>
<thead>
<tr>
<th>Status</th>
<th>Totals</th>
<th>Critical</th>
<th>Important</th>
<th>Moderate</th>
<th>Low</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installed</td>
<td>13</td>
<td>7</td>
<td>2</td>
<td>0</td>
<td>4</td>
</tr>
<tr>
<td>Missing</td>
<td>260</td>
<td>130</td>
<td>93</td>
<td>32</td>
<td>5</td>
</tr>
<tr>
<td>Totals</td>
<td>273</td>
<td>137</td>
<td>95</td>
<td>32</td>
<td>9</td>
</tr>
</tbody>
</table>

**Screenshot 68 – Sample report showing network patching status**

- Chart displaying the number of installed and missing service packs
- Chart displaying the number of installed and missing patches, grouped by severity
Appendix: GFI LANguard default reports

- Screenshot 69 – Sample report showing network patching status
  3 List showing the top 10 missing security updates
  4 List showing the top 20 most vulnerable host machines, as a result of missing patches and service packs. The number of vulnerabilities detected is split according to severity

Use this report to:

- Illustrate the status of patches and service packs for host machines on the network.

8.1.16 Missing patches grouped by host

- Screenshot 70 – Sample report showing missing patches grouped by host
  1 Host machine details on which missing patches were detected
  2 List of missing patch details for each host, including severity and URL link for further information

Use this report to:

- List missing patches grouped by host machine, including URL links providing further information on each missing patch.
8.1.17 Missing patches grouped by operating system

Screenshot 71 – Sample report showing missing patches grouped by operating system

| 1 | Missing patch details for each operating system |
| 2 | List of host details on which specific patches were found to be missing |

Use this report to:

- List missing patches grouped by operating system, including the host machine names for each missing patch.

8.1.18 Missing patches grouped by severity

Screenshot 72 – Sample report showing missing patches grouped by severity

| 1 | Missing patch details for each severity level |
| 2 | List of host details on which specific patches were found to be missing |

Use this report to:

- List missing patches grouped by severity, including the host machine names for each missing patch.

8.1.19 Installed patches grouped by host

Screenshot 73 – Sample report showing installed patches grouped by host
Host machine details on which installed patches were detected

List of installed patch details for each host, including severity, URL link for further information and indication if the patch can be uninstalled

Use this report to:

- List installed patches grouped by host machine, including URL links providing further information on each installed patch.

8.1.20 Installed patches grouped by operating system

<table>
<thead>
<tr>
<th>Patch</th>
<th>Bulletin ID</th>
<th>Posted Date</th>
<th>Severity</th>
<th>Uninstallable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>911565</td>
<td>MS06-005</td>
<td>2006-02-14</td>
<td>Critical</td>
<td>No</td>
<td>Security Update for Windows Media Player 9 (KB911565)</td>
</tr>
<tr>
<td>330994</td>
<td>MS03-014</td>
<td>2004-04-09</td>
<td>Critical</td>
<td>No</td>
<td>April 2003, Security Update for Outlook Express 5.5 Service Pack 2</td>
</tr>
</tbody>
</table>

Use this report to:

- List installed patches grouped by operating system, including the host machine names for each installed patch.

8.1.21 Installed patches grouped by severity

<table>
<thead>
<tr>
<th>Patch</th>
<th>Bulletin ID</th>
<th>Posted Date</th>
<th>Uninstallable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>811113</td>
<td>Not Available</td>
<td>2006-04-25</td>
<td>No</td>
<td>Windows XP Service Pack 2</td>
</tr>
</tbody>
</table>

Use this report to:

- List installed patches grouped by severity, including the host machine names for each installed patch.
8.1.22 Remediation history by host

![Screenshot 76 – Sample report showing deployment history by host](image)

1. Host machine on which deployments were made
2. List of deployment details for each host, including file names deployed, and deployment status

Use this report to:
- Display patches deployment information grouped by host machine, including deployment details such as date and status.

8.1.23 Remediation history by date

![Screenshot 77 – Sample report showing deployment history by date](image)

1. Deployment starting date
2. List of deployment details grouped by host, including file names deployed, and deployment status

Use this report to:
- Display patches deployment information by date and time, including details such as host machine names for each deployment.

8.1.24 Remediation history by patch/application

![Screenshot 78 – Sample report showing deployment history by patch](image)
8.2 Network and software audit reports

8.2.1 Software audit

Screenshot 79 – Sample report showing software audit

1. List showing the top 10 host machines with unauthorized applications
2. List showing the top 10 unauthorized applications
Appendix: GFI LANguard default reports

Use this report to:
- Identify unauthorized applications installed on host machines, detected during network security scans
- Identify the top 10 host machines with unauthorized applications
- Identify the top 10 unauthorized applications with highest number of installations
- Identify the top 20 installed applications
- Graphically represent the number of host machines without security applications, or with security applications not updated.

8.2.2 Operating system and service pack distribution

Screenshot 80 – Sample report showing operating system and service pack distribution
Chart displaying distribution percentage of each operating system on the network

List of operating systems, including the number of host machines on which they are installed

Chart displaying service pack distribution for each operating system

List of operating system service packs, including the number of host machines on which they are installed

Use this report to:
- Graphically represent operating systems detected on the network
- List the number of host machines for each operating system
- Graphically represent service packs detected on the network for each operating system
- List the number of host machines for each service pack installed.

8.2.3 System information

<table>
<thead>
<tr>
<th>Name</th>
<th>Total Space</th>
<th>Free Space</th>
<th>File System Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:</td>
<td>14.65 GB</td>
<td>5.20 GB</td>
<td>NTFS</td>
</tr>
<tr>
<td>D</td>
<td>23.82 GB</td>
<td>312.30 MB</td>
<td>NTFS</td>
</tr>
</tbody>
</table>

Groups and Users

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Administrators have complete and unrestricted access to the computer domain</td>
</tr>
<tr>
<td>Members: HX3Soin, HX3Administrator, HX3LNSS_MONITOR_USR</td>
<td></td>
</tr>
<tr>
<td>Backup Operators</td>
<td>Backup Operators can override security restrictions for the sole purpose of backing up or restoring files</td>
</tr>
<tr>
<td>Guests</td>
<td>Guests have the same access as members of the Users group by default, except for the Guest account which is further restricted</td>
</tr>
</tbody>
</table>

Screenshot 81 – Sample report showing system information

1. Host machine IP and name
2. Host machine details, including MAC address and domain
3. Uptime details for each host machine, including time of day and uptime value
4. Disk utilization details for each host machine, including drive name, file system type, total storage space and free storage space
### SNMP Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object_ID</td>
<td>1.3.6.1.4.1.1111.1.3.1.3 (NT Domain Console)</td>
</tr>
<tr>
<td>sysDescr</td>
<td>Hardware: x86 Family 15 Model 9 Stepping FAT/AT COMPAQ</td>
</tr>
<tr>
<td>sysName</td>
<td>PROJECT</td>
</tr>
<tr>
<td>sysUpTime</td>
<td>18 minutes, 50 seconds</td>
</tr>
<tr>
<td>Vendor</td>
<td>Microsoft</td>
</tr>
</tbody>
</table>

### Services

<table>
<thead>
<tr>
<th>Service Name</th>
<th>Status</th>
<th>Startup Type</th>
<th>Account Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Server</td>
<td>Running</td>
<td>Auto</td>
<td>NT AUTHORITY\LocalService</td>
</tr>
<tr>
<td>SNMP Details</td>
<td>Running</td>
<td>Manual</td>
<td>NT AUTHORITY\LocalService</td>
</tr>
<tr>
<td>Application Management</td>
<td>Stopped</td>
<td>Manual</td>
<td>LocalSystem</td>
</tr>
<tr>
<td>ASF.NET State Service</td>
<td>Stopped</td>
<td>Manual</td>
<td>NT AUTHORITY\NetbookService</td>
</tr>
<tr>
<td>Windows Audio</td>
<td>Running</td>
<td>Auto</td>
<td>LocalSystem</td>
</tr>
<tr>
<td>Background Intelligent Transfer Service</td>
<td>Stopped</td>
<td>Manual</td>
<td>LocalSystem</td>
</tr>
<tr>
<td>Computer Browser</td>
<td>Running</td>
<td>Auto</td>
<td>LocalSystem</td>
</tr>
</tbody>
</table>

### Processes

- **apache**
  - PID: 2404
  - PPID: 1040
  - User Name: LOCAL SERVICE
  - Domain: NT AUTHORITY
  - Handle Count: 107
  - Thread Count: 0
  - Priority: 0

- **Windbiz.exe**
  - PID: 22836
  - PPID: 2372
  - User Name: Administrator
  - Path: C:\WINDOWS\system32\windbiz.exe
  - Domain: MARY
  - Command Line: "C:\WINDOWS\system32\windbiz.exe"
  - Handle Count: 83
  - Thread Count: 1
  - Priority: 0

**Screenshot 82 – Sample report showing system information**

<table>
<thead>
<tr>
<th>6</th>
<th>SNMP details for each host machine, including name and description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Service details for each host machine, including name, description, status, startup type and account name</td>
</tr>
<tr>
<td>8</td>
<td>Process details for each host machine, including process ID and account name</td>
</tr>
</tbody>
</table>
### USB Devices

<table>
<thead>
<tr>
<th>Device Type</th>
<th>Description</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Root Hub</td>
<td></td>
<td>(Standard USB Host Controller)</td>
</tr>
<tr>
<td>USB Root Hub</td>
<td></td>
<td>(Standard USB Host Controller)</td>
</tr>
<tr>
<td>USB Root Hub</td>
<td></td>
<td>(Standard USB Host Controller)</td>
</tr>
</tbody>
</table>

There were no Blacklisted USB Devices vulnerabilities detected.

### Virtual Devices

- **WAN Miniport (LZTP)**
  - DHCP Set: False
- **WAN Miniport (PPTP)**
  - MAC Address: 00:50:54:50:30:30
  - DHCP Set: False
- **WAN Miniport (PPPOE)**
  - MAC Address: 33:50:6F:45:30:30
  - DHCP Set: False

There were no Blacklisted Wireless Devices vulnerabilities detected.

### Shares

<table>
<thead>
<tr>
<th>Name</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN$</td>
<td>Remote Admin</td>
</tr>
<tr>
<td>C\</td>
<td>share</td>
</tr>
<tr>
<td>C$</td>
<td>Default Share</td>
</tr>
<tr>
<td>CD Drive (F)</td>
<td>N/A</td>
</tr>
<tr>
<td>D\</td>
<td>share</td>
</tr>
<tr>
<td>D$</td>
<td>Default Share</td>
</tr>
<tr>
<td>E\</td>
<td>share</td>
</tr>
<tr>
<td>E$</td>
<td>Default Share</td>
</tr>
<tr>
<td>IPC$</td>
<td>Remote IPC</td>
</tr>
<tr>
<td>XP Prof. - SP2 - VXPGE</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Open Ports

- **TCP Ports**
  - 2.502 [Full Port List]
  - 2.107 [Full Port List]
  - 2.100 [Full Port List]
  - 2.103 [Full Port List]
  - 1.501 [Full Port List]
  - 199 [Netbios - NetBIOS Session Service]

- **UDP Ports**
  - 1.300 [Full Port List]
  - 1.492 [Full Port List]
  - 139 [Net Port List]

**Screenshot 83 – Sample report showing system information**

- List showing USB devices, blacklisted USB devices, network cards and blacklisted wireless devices
- Share folder details for each host machine, including name and remarks
- Open port details for each host machine, including port number and name
Appendix: GFI LANguard default reports

- Installed Applications
  - Adobe Reader 7 CE
  - Adobe Systems Incorporated
  - Adobe Flash Player ActiveX
  - Adobe Systems
  - Ad-Aware SE Personal Edition
  - Lavasoft
  - ATI Display Driver
  - CCleaner (remove only)
  - F-Pro Antivirus for Windows
  - GFI EventManager 7 ReportPack
  - GFI Software Ltd.
  - GFI LANguard Network Security Scanner 8C
  - GFI
  - GFI Report Center Framework
  - GFI Software

- Unauthorized Applications
  - Ad-Aware SE Personal Edition
  - Lavasoft
  - Adobe Flash Player ActiveX
  - Adobe Systems
  - CCleaner (remove only)
  - GFI PrintScreen

- Password Policy
  - Minimum Password Age
  - Maximum Password Age
  - Minimum Password Length
  - Force Logoff
  - Password History

- Security Audit Policy
  - Audit account login event
  - Audit account management
  - Audit directory service access
  - Audit privilege use
  - Audit process tracking
  - Audit system events

- Registry Information
  - Node Name
  - Registry Entry

Use this report to:
- List detailed technical information for each host machine, including services, installed applications, policies and devices.
- List showing password policy details and security audit policy details.
8.2.4 Computer properties

![Computer properties screenshot](image1)

Use this report to:
- List information for each host machine, including MAC address, network role and domain.

8.2.5 Uptimes

![Uptimes screenshot](image2)

Use this report to:
- List uptime for each host machine, grouped by network scan.

8.2.6 Disk utilization

![Disk utilization screenshot](image3)

Use this report to:
- List information for each file system type.
Disk utilization details for each host machine, including drive name, file system type, total storage space and free storage space

Use this report to:

- List disk utilization information for each host machine, including file system type, total space and free space.

### 8.2.7 Groups and users

- Host machine IP and name
- List showing group details for each host machine, including name, description and members
- List of user details for each group, including user name, privilege, last logon and bad password count

Use this report to:

- List group and user information for each host machine.
8.2.8 SNMP information

![Sample report showing SNMP information](image1)

Use this report to:
- List SNMP information for each host machine, including name, description and uptime.

8.2.9 Services

![Sample report showing services](image2)

Use this report to:
- List service information for each host machine, including description, status, startup type and account name.
8.2.10 Processes

Screenshot 91 – Sample report showing processes

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Host machine IP and name</td>
</tr>
<tr>
<td>2</td>
<td>Process details for each host machine, including process ID and account name</td>
</tr>
</tbody>
</table>

Use this report to:

- List process properties for each host machine.
### 8.2.11 Hardware Audit

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows XP Service Pack 2</td>
</tr>
<tr>
<td>Processors</td>
<td>Intel® Core(TM)2 Quad CPU Q6600 @ 2.40GHz</td>
</tr>
<tr>
<td>Vendor</td>
<td>Genuine Intel</td>
</tr>
<tr>
<td>Speed</td>
<td>2405 MHz</td>
</tr>
<tr>
<td>Motherboards</td>
<td>ASUSTeK Computer Inc.</td>
</tr>
<tr>
<td>Name</td>
<td>FBK</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>REV 1.xx</td>
</tr>
<tr>
<td>BIOS name</td>
<td>BIOS Date: 07/03/07 10:31:10 Ver. 08.00.12</td>
</tr>
<tr>
<td>BIOS vendor name</td>
<td>American Megatrends Inc.</td>
</tr>
<tr>
<td>Memory</td>
<td>4.00 GB Physical memory</td>
</tr>
<tr>
<td>Free physical memory</td>
<td>2.06 GB</td>
</tr>
<tr>
<td>Virtual memory</td>
<td>8.22 GB</td>
</tr>
<tr>
<td>Free virtual memory</td>
<td>5.91 GB</td>
</tr>
<tr>
<td>NVIDIA GeForce 7600 GT</td>
<td>NVIDIA</td>
</tr>
<tr>
<td>Current resolution</td>
<td>1280 x 1024 x 32 x 0 Hz</td>
</tr>
<tr>
<td>Display Adapters</td>
<td>139281972673624</td>
</tr>
<tr>
<td>Floppy disk drive</td>
<td>Floppy disk drive</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>ASUS</td>
</tr>
<tr>
<td>Media type</td>
<td>Floppy disk drive</td>
</tr>
<tr>
<td>Description</td>
<td>Optical disk drive</td>
</tr>
<tr>
<td>Interface type</td>
<td>CD-ROM DriveDVD Writer</td>
</tr>
<tr>
<td>Media type</td>
<td>CD-ROM DriveDVD-ROM</td>
</tr>
<tr>
<td>Drive(s)</td>
<td>11192832772039</td>
</tr>
<tr>
<td>Serial Number</td>
<td>LDV0403T FV2043D 5CS1 CD-ROM Device</td>
</tr>
<tr>
<td>Name</td>
<td>Total Space</td>
</tr>
<tr>
<td>C:</td>
<td>6.00 GB</td>
</tr>
<tr>
<td>D:</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Screenshot 92 - Sample report showing hardware audit - part 1 of 2
## USB Devices

<table>
<thead>
<tr>
<th>USB Root Hub</th>
<th>Description</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB Root Hub</td>
<td>Description</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>USB Root Hub</td>
<td>Description</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>USB Root Hub</td>
<td>Description</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>USB Root Hub</td>
<td>Description</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>USB Root Hub</td>
<td>Description</td>
<td>Manufacturer</td>
</tr>
</tbody>
</table>

## Network Devices

### Physical Devices

**Marvell Yukon 88E8011/88E8010 PCI Gigabit Ethernet Controller**
- **Vendor:** Intel
- **MAC Address:** 00:11:68:6D:8C:72
- **IP Address(es):** 192.168.100.27
- **Host Name:** 86m
- **DHCP Set:** False
- **DNS Server(s):** 192.168.100.26, 212.93.140.1
- **Gateway(s):** 192.168.100.1
- **Status:** Plugged In

### 1284 Net Adapter
- **Vendor:** Microsoft
- **MAC Address:** 92:15:2D:49:AC:78
- **DHCP Set:** False
- **Status:** Unplugged

### Virtual Devices

**WAN Miniport (LZTP)**
- **Vendor:** Microsoft
- **DHCP Set:** False
- **Status:** Unplugged

**WAN Miniport (IP)**
- **Vendor:** Microsoft
- **DHCP Set:** False
- **Status:** Unplugged

**WAN Miniport (PPPoE)**
- **Vendor:** Microsoft
- **MAC Address:** 30:50:0F:45:02:30
- **DHCP Set:** False
- **Status:** Unplugged

## Disabled Network Devices

### Windows Mobile-based Device
- **Status:** Unplugged

## Other Devices

### ACPI Fixed Feature Button
- **Description:** ACPI Fixed Feature Button
- **Manufacturer:** (Standard system devices)
- **Device Class:** System Devices

### Programmable interrupt controller
- **Description:** Programmable interrupt controller
- **Manufacturer:** (Standard system devices)
- **Device Class:** System Devices

### System timer
- **Description:** System timer
- **Manufacturer:** (Standard system devices)
- **Device Class:** System Devices

### Direct memory access controller
- **Description:** Direct memory access controller
- **Manufacturer:** (Standard system devices)
- **Device Class:** System Devices
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Host machine IP and name</td>
</tr>
<tr>
<td>2</td>
<td>Processor information</td>
</tr>
<tr>
<td>3</td>
<td>Motherboard information</td>
</tr>
<tr>
<td>4</td>
<td>Physical and virtual memory</td>
</tr>
<tr>
<td>5</td>
<td>Display adaptors</td>
</tr>
<tr>
<td>6</td>
<td>Storage devices</td>
</tr>
<tr>
<td>7</td>
<td>Drive name, space allocation and file system type</td>
</tr>
<tr>
<td>8</td>
<td>USB device information</td>
</tr>
<tr>
<td>9</td>
<td>Blacklisted USB devices</td>
</tr>
<tr>
<td>10</td>
<td>Physical and virtual network devices</td>
</tr>
<tr>
<td>11</td>
<td>Blacklisted network devices</td>
</tr>
<tr>
<td>12</td>
<td>Other devices</td>
</tr>
</tbody>
</table>

Use this report to identify all devices detected on the network for scan computers.

**NOTE:** Devices are grouped by categories. Categories with no devices detected are not displayed.

### 8.2.12 Shares

<table>
<thead>
<tr>
<th>Name</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADMIN</td>
<td>Remote Admin</td>
</tr>
<tr>
<td>C$</td>
<td>Default share</td>
</tr>
<tr>
<td>IPC$</td>
<td>Remote IPC</td>
</tr>
</tbody>
</table>

*Screenshot 94 – Sample report showing shares*

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Host machine IP and name</td>
</tr>
<tr>
<td>2</td>
<td>Share folder details for each host machine, including name and remarks</td>
</tr>
</tbody>
</table>

Use this report to:

- List information on shared folders for each host machine.
8.2.13 Open ports

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Service Pack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista</td>
<td>1</td>
</tr>
</tbody>
</table>

TCP Ports
- 80 [ Hypertext Transfer Protocol (HTTP) ]
- 80 [ Full Port List ]
- 135 [ DCE endpoint resolution ]
- 135 [ Full Port List ]
- 139 [ NetBIOS NetBIOS Session Service ]
- 139 [ Full Port List ]
- 445 [ Full Port List ]
- 445 [ Microsoft-DS Active Directory, Windows shares ]
- 1,170 [ LNSS attendant ]
- 1,170 [ Full Port List ]

Screenshot 95 – Sample report showing open ports

1. Host machine IP and name
2. Open port details for each host machine, including port number and name

Use this report to:
- List open ports detected for each host on the network including port number and name.

8.2.14 Installed applications by Host

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Service Pack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP</td>
<td>2</td>
</tr>
</tbody>
</table>

Installed Applications
- Adobe Flash Player 9
  - Publisher: Adobe Systems Inc.
  - Version: 9
  - Authorized: Yes
- AVG AntiVirus
  - Publisher: AVG Technologies
  - Version: 7.1.428
  - Authorized: Yes
- GFI LANguard Network Security Scanner 8.0
  - Publisher: GFI
  - Version: 8.0
  - Authorized: Yes

Screenshot 96 – Sample report showing installed applications

1. Host machine IP and name
2. Installed application details for each host machine, including name, publisher and version

Use this report to:
- List installed applications detected for each network host scanned, including publisher and version details.
### 8.2.15 Application Inventory

**Screenshot 97 - Sample report showing applications inventory**

<table>
<thead>
<tr>
<th>Application Publisher</th>
<th>Adobe Systems Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version Number</strong></td>
<td>9</td>
</tr>
<tr>
<td><strong>Authorized</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>IP address</strong></td>
<td>80.143.32.140</td>
</tr>
<tr>
<td><strong>Host Name</strong></td>
<td>Jane</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows XP</td>
</tr>
<tr>
<td><strong>SP</strong></td>
<td>2</td>
</tr>
</tbody>
</table>

- **Installed application name and details**
- **List of computers having application installed**

Use this report to:

- Identify all computers which have specific software installed on them.

### 8.2.16 Antivirus Applications

**Screenshot 98 – Sample report showing installed anti-virus applications**

<table>
<thead>
<tr>
<th>Name/Publisher</th>
<th>AVG Antivirus</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
<td>7.1.428</td>
</tr>
<tr>
<td><strong>Defn. files up-to-date</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Last</strong></td>
<td>5/22/2009</td>
</tr>
<tr>
<td><strong>Last</strong></td>
<td>5:31:02AM</td>
</tr>
<tr>
<td><strong>Supported</strong></td>
<td>Auto</td>
</tr>
</tbody>
</table>

- **Host machine IP and name**
- **Antivirus application details for each host machine, including name, publisher and version**

Use this report to:

- List installed antivirus applications detected for each network host scanned, including publisher and version details.
Appendix: GFI LANguard default reports

8.2.17 Auditing Policies

![Screenshot 99 – Sample report showing policies]

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host machine IP and name</strong></td>
<td>1</td>
</tr>
<tr>
<td><strong>Password policy details for each host machine, including minimum password length and password history</strong></td>
<td>2</td>
</tr>
<tr>
<td><strong>List showing security audit policy details for each host machine</strong></td>
<td>3</td>
</tr>
</tbody>
</table>

Use this report to:

- List password and security audit policy settings for each network host scanned.

8.2.18 Registry information

![Screenshot 100 – Sample report showing registry information]
Use this report to:
- List system related registry information for each network host scanned.

### 8.3 Results comparison

#### 8.3.1 Network security log by date

<table>
<thead>
<tr>
<th>Network security scans to be compared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host machine on which the comparison was made</td>
</tr>
<tr>
<td>List of differences found between comparisons for each host machine. Differences are grouped by category, including backdoors, missing hot fixes, password policy, USB devices and applications</td>
</tr>
</tbody>
</table>

Use this report to:
- Compare results of consecutive scans that have a common profile and target, grouped by scan date.
8.3.2 Network security log by host

Screenshot 102 – Sample report showing network security log by host

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Host machine on which the comparison was made</td>
</tr>
<tr>
<td>2</td>
<td>Network security scans which were compared</td>
</tr>
<tr>
<td>3</td>
<td>List of differences found between comparisons for each host machine. Differences are grouped by category, including backdoors, missing hot fixes, password policy, USB devices and applications</td>
</tr>
</tbody>
</table>

Use this report to:
- Compare results of consecutive scans that have a common profile and target, grouped by host machine.
### 8.3.3 Baseline changes comparison

<table>
<thead>
<tr>
<th>Screenshot 103 – Sample report showing security settings comparison</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Detected Host</strong></td>
</tr>
<tr>
<td>80.143.32.226 - GamesPC</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>80.143.32.211 - Andrew</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Use this report to compare results between a chosen computer, used as benchmark, and host machines scanned with the same profile and having the same target.
9. Troubleshooting

9.1 Introduction
The troubleshooting chapter explains how you should go about resolving any software issues that you might encounter. The main sources of information available to users are:

- The manual – most issues can be solved by reading this manual.
- GFI Knowledge Base articles
- Web forum
- Contacting GFI Technical Support

9.2 Knowledge Base
GFI maintains a Knowledge Base, which includes answers to the most common problems. If you have a problem, please consult the Knowledge Base first. The Knowledge Base always has the most up-to-date listing of technical support questions and patches. To access the Knowledge Base, visit http://kbase.gfi.com/.

9.3 Web Forum
User to user technical support is available via the web forum. The forum can be found at: http://forums.gfi.com/.

9.4 Request technical support
If you have referred to this manual and our Knowledge Base articles, and you still cannot solve issues with the software, contact the GFI Technical Support team by filling in an online support request form or by phone.

- **Online**: Fill out the support request form on: http://support.gfi.com/supportrequestform.asp. Follow the instructions on this page closely to submit your support request.
- **Phone**: To obtain the correct technical support phone number for your region please visit: http://www.gfi.com/company/contact.htm.

**NOTE**: Before you contact our Technical Support team, please have your Customer ID available. Your Customer ID is the online account number that is assigned to you when you first register your license keys in our Customer Area at: http://customers.gfi.com.

We will answer your query within 24 hours or less, depending on your time zone.
9.5 Build notifications

We strongly suggest that you subscribe to our build notifications list. This way, you will be immediately notified about new product builds. To subscribe to our build notifications, visit: http://www.gfi.com/pages/productmailing.htm.
Index

C
configuration settings 42
custom reports 3, 5, 15, 24, 25

D
data filters 5, 15
database source 40, 41, 42
default reports 3, 9, 14
distribution of reports 4

E
export reports 5

F
favorite reports 3, 14, 24
filter conditions 17
framework 1, 2, 3, 4, 7

I
installation 5, 7, 8, 39

L
license 31

N
navigation button 3, 9, 10, 11, 14, 15,
21, 23, 24, 27, 28, 30, 31, 32,
33, 35, 36, 39, 40, 41, 48, 49

P
product ReportPack 3
Product Selection drop down list 8, 48

R
Report scheduling 2, 4

S
schedule activity monitor 31

scheduled reports 3, 5, 30, 32
security scan 18
System requirements 7

T
Troubleshooting 85

U
user interface 3, 30, 31, 39

W
wizard 7, 33